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1 INTRODUCTION 
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1.1 ABOUT 

ArCADia-GAS INSTALLATIONS is a tool that extends INTERsoft-INTELLICAD/AutoCAD or ArCADia-

START with the functionalities necessary to create professional internal gas installation designs. The 

software is meant both for gas network and installation designers, as well as all the people working 

in the sanitary branch and installations branch in the construction industry.  When using the 

ArCADia-GAS INSTALLATIONS software the user has the possibility to create drawings of the internal 

gas installation in architectural building projections based on objects and automatically create 

calculation diagrams and extensions of the installations. The user may also employ a library of 

objects used when designing, along with an option to edit the objects and add technical parameters 

to them. 

Apart from the option to efficiently create drawings of the installations, the software also carries out 

the calculations necessary for designing the installation correctly (validity checks for the assumed 

diameters, verifying the scope of pressure loss upstream from gas appliances), selects gas pipelines 

and receivers and enables drafting a professional technical report. This way it provides a perfect tool 

for designing internal gas installations. 

1.2 FEATURES AND FUNCTIONALITIES OF THE PROGRAM 

The technical scope of functionalities provided by the software and its basic functions: 

 creating internal gas installation drawings in the scope of routing pipelines, shut-off fittings 

and gas appliances, 

 creating extensions and calculation diagrams, 

 determining gas flow in design sections of the gas installation, 

 calculating the pressure loss  in characteristic paths and comparing these to the maximum 

pressure loss for an installation, 

 running validity checks on a designed gas installation, 

 generating calculation reports, 

 automatically generating a list of elements (legend) used in the project, 

 generating lists of materials used in the project. 

The ArCADia-GAS INSTALLATIONS software was developed based on the following regulations, 

standards and scientific and technical publications: 

Legal acts: 

 Regulation of the Minister of Infrastructure of 26 April 2013 on the technical conditions to be 

met by buildings and their locations (Polish Journal of Laws no. 75 item 690) as amended 

 Ordinance of the Minister of Infrastructure of 30 July 2001 on the technical conditions to be 

met by gas networks and their location (Dz. U. 2013 r, poz.640). 

Standards: 

 PN-C-04750: 2002 – Gaseous fuels. Classification, marking and requirements. 
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 PN-C-04753:2002 – natural gas. Quality of gas supplied to consumers from the local 

distribution system. 

 PN-76/M-34034 – Pipelines. Pressure loss calculation principles. 

 PN-EN 1057:2006 – Copper and copper alloys. Seamless, round copper tubes for water and 

gas in sanitary applications 

 PN-74/H74200: 1998 - Steel pipes with seam, threaded 

 PN-EN 10208-1:2009 Steel pipes for pipelines for combustible fluids - Technical delivery 

conditions - Part 1: Pipes Of Requirement Class A 

 PN-EN 10208-2:2009 Steel pipes for pipelines for combustible fluids - Technical delivery 

conditions - Part 2: Pipes Of Requirement Class B 

 PN-EN 10210-2:2007 - Hot finished structural hollow sections of non-alloy and fine grain 

steels - Part 2: tolerances, dimensions and sectional properties. 

References: 

 Bąkowski Konrad: Sieci i instalacje gazowe. Poradnik projektowania budowy i Wyd. III 

zmienione. WNT, Warsaw, 2002. 

 Ryszard Zajda, Zdzisław Gebhard. Instalacje gazowe oraz lokalne sieci gazów płynnych. 

Projektowanie, wykonywanie, eksploatacja. Warsaw, 1995 
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2 INSTALLING  AND  RUNNING  THE  PROGRAM 
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2.1 HARDWARE REQUIREMENTS 

 Pentium IV PC (PIV D recommended) 

 2GB RAM (4GB recommended) 

 Approximately 1GB of free HDD space for the installation 

 DirectX 9.0 compatible graphics card 

 Windows Vista 32/64-bit OS, Windows 7 32/64-bit or Windows 8 32/64-bit 

 DVD-ROM drive 

2.2 INSTALLING 

The program installation is started automatically when the CD is inserted into the CD drive. The 

installation should be started manually if the Autostart function is disabled. Open the CD content 

(Computer/CD drive), and run the Setup.exe file from the program folder. Once the installation is 

started, proceed according to instructions displayed on the screen. 

2.3 RUNNING 

The ArCADia software: 

The software may be started by double-clicking on the ArCADia-START program icon located on the 

Desktop and then selecting one of the icons on the ribbon in the gas tab. 

The AutoCAD or INTERsoft-INTELLICAD software: 

The software may be started by double-clicking on the CAD program icon located on the Desktop and 

then selecting one of the icons in the ArCADia-GAS INSTALLATIONS toolbar. 

2.4 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 

 A standard DWG drawing file. 

 Any of the following sample drawings supplied with the ArCADia-START or INTERsoft-

INTELLICAD software may be used. 

 A DXF drawing exchange file. 

 A DWF network transmission file. 

 A DWT drawing template file. 

In order to quickly access the last edited drawing choose File> <file name>. The software stores the 

names of the last four drawings. In order to quickly access a drawing from the Open drawing 

dialogue box, double-click the drawing name. 

A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. 

All you need to do to open the drawing in IntelliCAD is to double-click the file. Miniature drawings 

displayed when browsing facilitate the identification of the selected drawing. 
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Opening an existing drawing 

The ArCADia software:  

Use one of the following methods: 

o Choose the Home ribbon and then in the Files logical group choose the Open button. 

o Press the ArCADia  button and then press the Open button 

The AutoCAD or INTERsoft-INTELLICAD software: 

Use one of the following methods: 

o Choose File>Open. 

o On the Standard toolbar select the Open  tool. 

o Write open and then press Enter. 

 

Common for the ArCADia, AutoCAD and INTERsoft-INTELLICAD software: 

1. Choose the type of the file you want to open from the file type. 

2. Choose the folder that contains the selected drawing. 

3. Do one of the following: 

o Choose the drawing that you want to open and click Open. 

o Double-click the drawing you want to open. 

If the drawing requires a password, provide the password, then click OK to verify the password and 
then click Open again. 

2.5 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing use one of the following methods: 

 On the Standard toolbar click Save. 

 Choose File>Save. 

 Write save and then press Enter. 

 Write qsave and then press Enter. 

When you save a particular drawing for the first time, the system will display a dialogue box Save 

drawing as, which enables you to select the folder and provide the name for the drawing. You can 

use any name at all when saving the drawing for the first time. In order to save the same drawing 

under a different name later, select File>Save as and then type in the new name. 
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2.6 AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or another system error, it is necessary to save 

your drawing files often. The software may be configured to periodically save your drawings 

automatically. The Autosave setting determines the interval in minutes between automatic saves. 

The software resets this interval each time the user saves a drawing file (feature available in 

INTERsoft-INTELLICAD and AutoCAD). 

When the Autosave feature is activated, the software creates copies of the drawing. This file is 

automatically saved to the folder provided under Options>Paths/Files>Temporary file and given the 

extension indicated in the Drawing autosave file extension (SV$ by default). 

Configuring INTERsoft-INTELLICAD to automatically save drawings 

1. Do one of the following: 

 Select Tools>Options. 

 Write config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to enable the Autosave feature 

and select the autosave frequency. 

4. Click OK. 
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3  WORKING WITH THE SOFTWARE 
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3.1 BASIC INFORMATION ABOUT THE SOFTWARE 

ArCADia-GAS INSTALLATIONS allows the design of an external gas installation in the scope of 
determining the route of gas pipelines, location of fittings and gas appliances, as well as carrying out 
calculations to verify the correct selection of diameters based on an assessment of the pressure loss 
in the critical path and compared to the maximum pressure loss determined for the installation 
supplied with a particular type of gas from a HP or IP connection. 
 
The first stage of a project is always to complete the drawing part. Inserting any gas installation item 
activates the software. The software was designed to ensure a flexible (free) course of action when 
creating a drawing. 
 
You can start drawing any way you like: 

Phase I - creating a drawing 

1. Designing a gas installation may be started by defining the Gas fuel (type of gas) to be used 

for a given installation. It is at the same time completing the main gas box source element 

with initial parameters for the installation design: gas fuel parameters, connection 

parameters, installation parameters and calculation criteria. 

2. Then the next building’s gas “power source” element can be inserted – the Main gas box 

object. For a given element the correct type of gas should be selected, previously defined in 

the project settings. 

3. Then you can insert the Gas receiver items in the architectural projection by providing them 

with geometric parameters, technical parameters, a gas consumption simultaneity group and 

assignment to the particular installation. 

4. The next step is to trace the pipelines in the drawing and connecting the main box 

and the gas receivers with the installation (connecting elements by means of a system of gas 

installation pipelines). When drawing the route of pipelines in the architectural projection, 

the user assigns them parameters. At the same time shut-off fittings, filters and a pressure 

reducer need to be inserted. Elements may also be inserted with default parameters and 

later on, during the selection stage, indicate specific manufacturers’ catalogues for selecting 

pipelines and shut-off fittings. 

5. Once the installation is drawn you can run a validity check on the designed installation 

layout:  

– verifying the connection to the gas box 

– verifying the connection of all the designed items: gas receivers, shut-off fittings, 

measurement devices 

– verifying the continuity of the installation – connections between all the installation 

sections. 

Phase II – calculations and material lists 
 

1. Once drawings are ready and validity checks of the installation have been performed, the 

user may control and correct the assumed diameters for the design sections. 

2. After clicking the Gas installation calculations and report icon the user generates tables that 

allow for choosing a calculation route including: critical one, longest one and the one with 

the highest load. 
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3. The user receives information on the total pressure losses, pressure recovery and pressure 

loss due to the difference in gas density and air density, total pressure loss, pressure 

upstream from the selected gas receiver. 

4. Based on the calculations generated by the software the user may assess the correct 

selection of diameters. For each calculation path between the main gas box and the gas 

receiver, the software determines the unit pressure loss applicable for one meter of the 

calculation path, which allows the user to determine in which design section is the unit 

pressure loss the highest. 

5. In the calculation table it is possible to introduce a new pipeline type, i.e. change the 

material, series of type and the diameter. After clicking the Apply button located in the Gas 

installation report window, all the changes introduced to the calculations table, the above-

mentioned changes in the diameters will be transferred to the graphical part.  

6. After confirming the correctness of the graphical part and the calculation part of the gas 

installation, the user may choose to generate: 

– an item list (legend) divided into symbols, number of pieces, marking, name 

– an RTF list of the materials and devices used in the project in order to allow for price 

estimations to be drafted for the installation. 
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4 SOFTWARE  ELEMENT  DESCRIPTION 
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4.1 THE PROJECT MANAGER 

The Project Manager enables to manage all elements of the ArCADia-GAS INSTALLATIONS program: 

pipelines, fittings, receivers, etc. In order to run the Project Manager, select the following icon: 

The ArCADia software: 

 The System ribbon ⇒ the Project logical group ⇒ Show/Hide Project Manager  

The AutoCAD or INTERsoft-INTELLICAD software: 

 The ArCADia-ARCHITECTURE toolbar ⇒ Show/Hide Project Manager  

or type 

 isa_tllv.  

 

Drawing 1. The Project Manager window  
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Icon Description  

 Add level above 

 Add level below 

 Delete level 

 Move level up/down 

 

The View tab 

 
Multiclipboard/Object selection 

Tab. 1  

Using the Project Manager window, the user can add and delete levels of the building or change 

their position in relation to each other. It is also possible to switch between views through the tabs 

situated to the right or to the left of the Project Manager.  

In the Project Manager window, it is also possible to switch off the objects that are not necessary at 

the moment by pressing the shaded bulb next to an object name. After clicking the shaded padlock, 

the user will have no possibility to insert any changes to a given object. By clicking the printer 

symbol, selected objects can be turned off from printing out in the same way. 

After selecting a level name in the tree in the Project Manager window, the Multiclipboard appears 

in the lower part of the window. It gives the user the possibility to copy objects from a given level. In 

order to be copied, they need to be selected in the object list. After the selection, they will be 

available to be pasted, e.g. into another level. 
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Adding and editing groups, managing objects 

 

Drawing 2. The Project Manager window, managing objects 

Using the window above, it is possible to change general settings for a given object group, such as 

the colour or the line thickness. It is also possible to select and edit the properties of all elements of a 

gas installation by clicking a group of objects, such as Gas pipes/Copper, with the right mouse 

button. The number of objects belonging to a group is given in [ ] brackets next to its name. After 

clicking a group with the right mouse button, the user can select the operations to be performed. 

Objects can be managed in the same way. In the Manager tree, it is possible to select e.g. all valves 

and to change the settings of descriptions, pens, fonts or run the renumbering, etc.  

4.2 3D VIEW 

Each object created in the ArCADia-GAS INSTALLATIONS is reflected in the 3D view. The 3D view tree 

is different from other views in that it gives no possibility to define object printing, as only a saved 3D 

image can be printed out. Instead of printing, it is possible to glaze an object using the ”glass” icon 

next to its name.  
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Drawing 3. The 3D View in the Project Manager window 

To enable the 3D view, select the following icon: 

The ArCADia software: 

 The System ribbon ⇒ the Project logical group ⇒ Show/Hide 3D view  

The AutoCAD or INTERsoft-INTELLICAD software: 

 The ArCADia-ARCHITECTURE toolbar ⇒ Show/Hide 3D view  

or type 

 isa_tv3d. 

The ArCADia-GAS INSTALLATIONS software adds its own tools to the INTERsoft-

INTELLICAD/AutoCAD menu, as described in the tables below. 

4.3 THE ARCADIA-GAS INSTALLATIONS TOOLBAR 

 

Drawing 4. ArCADia-GAS INSTALLATIONS tool ribbon (ArCADia software) 
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Drawing 5. ArCADia-GAS INSTALLATIONS toolbar (AutoCAD or INTERsoft-INTELLICAD software) 

I Option Description 

 

Show/Hide Project 
Manager 

Displays or hides the level management window. 
This feature is available in the View tab in the 
Show/Hide logical group. 

 Show options 
Enables settings the basic drawing options. This 
feature is available in the Home tab in the 
Modules logical group. 

 
Inserts gas box Inserts a gas box along with a description. 

 
Insert gas appliance Inserts a gas appliance along with a description. 

 
Insert gas valve Inserts a gas valve along with a description. 

 Insert gas meter Inserts a gas meter along with a description. 

 Insert filter Inserts a gas filter along with a description. 

 Insert gas reducer Inserts a gas reducer along with a description. 

 Inserts gas pipe Inserts a gas pipe along with a description. 

 
Insert gas pipe with 
continuous route 

Inserts a section of gas pipes along with  
a description. 

 Insert vertical gas pipe Inserts a vertical gas pipe along with a description. 

 
Change line into a gas 
pipe 

The CAD command line inserted (dash) will be 
changed into a gas pipe with the given parameters. 

 
Change installation 
height 

Enables changing the height of a group of objects 
of a gas installation. 

 
Gas installation 
extension 

Generates a gas installation extension. 

 
Installation branch 
extension 

Generates a gas installation branch extension. 

 
Gas installation 
axonometry 

Generates a gas installation axonometry. 

 
Gas installation branch 
axonometry 

Generates a gas installation branch extension. 

 Insert material list* Inserts a material lists table into the drawing. 
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Insert material list 
from selected 
elements* 

Inserts a user defined material lists table into the 
drawing. 

 Insert item list 
Inserts a gas installation item list along with 
graphical symbols, names, markings and quantity. 

 Selected items list 
Inserts a user defined gas item list along with 
graphical symbols, names, markings  
and quantity. 

 

Gas installation 
calculations and 
report* 

Displays the calculation tables and generates  
a report presenting the technical calculations and 
the validity of the designed network. 

 
Gas installation 
verification 

Generates a list of erroneously designed elements. 

 
Selection of installation 
elements 

Allows for automatic selection of gas installation 
elements. 

 Help* Displays the help window. 

* Icons marked with a triangle are extendable icons that have more than one command 

Tab. 1. Features of the ArCADia-GAS INSTALLATIONS toolbar 
 

4.4 GENERAL SOFTWARE OPTIONS 

To display the ArCADia general options dialog box, click the icon:  

The ArCADia software: 

 The System ribbon  Modules logical group    

The AutoCAD or INTERsoft-INTELLICAD software: 

 The System toolbar    

or type  

 ISA_O.  

This window includes the tabs of the available ArCADia software. 
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Drawing 6. ArCADia system options window 

Tracking options are displayed on the left (Drawing 7). In this window the user may define custom 

tracking and detection options.  

The Tracking precision control group 
 
Elements – software’s element detection precision (e.g. gas meter connectors)  

Axes – elements’ axes detection and tracking precision 

Angles – detection and tracking precision of the angles set in the Angles tracked control. 

The Angles tracked control group 

Here the user may add, using the  button, another item to the list of angles tracked and using the  

 button the user may remove the value of the angle tracked marked on the list. After adding an 

item, the total value of the angle should be input (the default value is 90.0°). 

 

Drawing 7. Tracking options window 
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After selecting the ArCADia-GAS INSTALLATIONS tab the software options window is displayed. 

 

Drawing 8. Software options window for the ArCADia-GAS INSTALLATIONS, the General tab 

 

Drawing 9. Software options window for the ArCADia-GAS INSTALLATIONS,  
the Default symbols tab 
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Drawing 10. Software options window for the ArCADia-GAS INSTALLATIONS, the Fittings tab 

In this window the user may define the settings in one of the three tabs: 

The General tab (Drawing 8)  

The Appearance control group  

Symbol scale  – setting the size of item symbols where the dimensions are not editable for the user. 

 Update all – Marking this check box will change the scale of all previously inserted symbols to 

the one defined by the user in the editing field next to the check box. 

The Gas fuels control group 

 

After clicking the  button the software will display the Gas fuel element properties window. 
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Drawing 11. Gas fuel element properties window 

The Gas fuel parameters control group  

The parameters listed in this section are used in calculating losses in the gas installation. 

The Gas fuel parameters control group 

Gas fuel family – the user selects the fuel family that will be used to power the installation from the 
drop-down list (in accordance with PN-C-04750:2002): 

 Manufactured – family 1 

 Natural – family 2 

 Liquefied C3-C4 – family 3 

 Hydrocarbon and air gas mixture – family 4 

 Biogas – family 5 

Gas fuel group – a drop-down list of gas fuel groups is assigned for every item from the list above. 
The user chooses the appropriate group. 

 
Manufactured gases family: 

 Low caloric – Sn group 

 Medium caloric – Ss group 

 High caloric – Sw group 
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Natural gases family: 

 Nitrogened – Ln group 

 Nitrogened – Lm group 

 Nitrogened – Ls group 

 Nitrogened – Lw group 

 High metane – E group 

Family – Liquefied Gases C3-C4: 

 Propane butane (P/B), 

 Industrial propane (P). 

Hydrocarbon and air gas mixture family: 

 Mixtures of liquefied gasses C3-C4 with air (GGP), 

 Natural gas and air mixture (GPZ). 

Family – Biogas: 

 Biogas BG. 

According to their personal knowledge and the information contained in the technical requirements 
(if available), the user should type in the following parameters: 

 Gas fuel density [kg/m3], 

 Gas fuel kinematic viscosity [m2/s], 

 Air density [kg/m3], 

 Normal conditions (after marking the checkbox the software will automatically assume air 

density as at normal conditions), 

 Combustion heat or fuel value [MJ/m3] – after marking one of these and inputting its value 

the second, unmarked parameter will be greyed out and calculated approximately. 

The Connection parameters control group  
 
Parameters listed in this section are used for checking if the installation was designed correctly. The 
user chooses the pressure listed in the technical requirements or other design guidelines from the 
allowed building supply pressure range: 

 low pressure (up to 10kPa inclusive), 

 medium pressure (from 10kPa to 500kPa), 

 increased medium pressure (from 500kPa to 1600kPa). 

After selecting the pressure in the connection, based on the conditions (or other guidelines), the user 
inputs the minimum and maximum pressure that may occur in reality in the gas connection. By 
default the software inserts hints about the range depending on the pipeline connection. 

 
The Gas installation parameters control group  

The parameters in this section are used for defining the criteria for selecting elements of the 

installation. 

Permissible pressure loss – in the editing field the user enters the permissible pressure loss in the 
installation in Pa. These values are selected by the user according to their own technical knowledge. 
It is suggested to select parameter values according to literature references. 
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This parameter constitutes the comparison base for assessing the validity of the pressure loss 
calculations carried out. 
 
Permissible unit gas pressure loss – in the editing field the user defines the permissible unit pressure 
loss for one meter of installation in Pa/m. This value is selected by the user according to their own 
technical knowledge or by using the adjacent checkbox 

 Automatically 
After marking the checkbox the software will automatically calculate unit loss for the installation, 
taking into account the total length of the installation. 
 
Maximum gas velocity in the pipelines – in the editing field the user inputs the maximum gas 
velocity in m/s, which may occur in the installation. This value is selected by the user according to 
their own technical knowledge. 
 
 

 
Tab. 2. Permissible pressure losses were adapted as per the study of R. Zajda and Z. Gebhardt. 

 

Gas fuel type Permissible pressure loss 
in the gas installation in the path to 

the receiver with the least favourable 
location 

Gas fuel family Gas fuel group Values in the low 
pressure range 

[Pa] 

Values  
in the medium 

pressure 
range 
[Pa] 

Manufactured Low caloric Sn Up to 100 150-250 

Medium caloric Ss Up to 150 150-250 

High caloric Sw Up to 150 150-250 

Natural Nitrogenated Lm Up to 100 150-250 

Ln Up to 150 150–300 

Ls Up to 150 150–300 

Lw Up to 150 250–400 

High methane content E Up to 150 250–400 

Hydrocarbon and air 
gas mixture 

Mixture of liquefied C3-
C4 with air 

GGP Up to 100 150 

Natural gas and air 
mixture 

GPZ Up to 100 150 

 
 

Tab. 3. Permissible pressure losses as per K. Bąkowski 

 

Gas fuel type Permissible pressure loss 
in the gas installation in the path to the 

receiver with the least favourable 
location 

Gas fuel family Gas fuel group Values in the low 
pressure range 

[Pa] 

Values  
in the 

medium 
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pressure 
range 
[Pa] 

Natural Nitrogenated Ls Up to 100 Up to 150 

Lw Up to 100 Up to 150 

High methane 

content 

E Up to 150 Up to 200 

Liquefied C3-C4 Propan butane B/P - 180 

Industrial propane - - 180 

 

The Default symbols tab (Drawing 9) 

The user may leave or insert his own markings for items in the gas installation that will be 
automatically inserted in the project.  
 
The Moulds tab (Drawing 10)  

Includes controls enabling the user to determine the manner of generating and presenting the 

moulds for installation geometry and material changes. 

The Appearance control group  

Symbol diameter – in this field the user determines the size of the symbol inserted at the point 

where the fittings set is generated (circle diameter). 

The Detection control group  

Connect into reduction moulds – ticking this box means that a change of diameter and direction or a 

change of diameter and a branch will be executed by means of a DN1/DN2 reduction elbow (three-

way or four-way reduction fitting) and not by means of two separate fittings (DN1 elbow + DN1/DN2 

reduction, three-way fitting or four-way fitting DN1 + DN1/DN2 reduction). 

Generate four-way fittings – ticking this box means that four-way fittings and not three-way fittings 

pairs will be generated for nodes where four pipelines meet, as would be the case if the box is not 

ticked. 

Typical angle detection precision and Angle – in this table the user determines the bends (Angles) to 

be treated as typical in the installation (e.g.: 30, 45, 60, 90°) and what angle value range (+/-) should 

be interpreted as a typical angle. 

Tab. 4. Typical Angles table 
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If in the case of the above example set of typical angles the users inputs 2° in the Angle detection 

precision field, then: 

 angles in the range of 28-32° will be treated as 30°, 

 angles in the range of 43-47° will be treated as 45°, 

 angles in the range of 58-62° will be treated as 60°, 

 angles in the range of 88-92° will be treated as 90°, 

The remaining turn angle will be represented by values read from element geometry. 

To summarize, as per the example angle settings assumed above: 

 a 30° elbow will be generated for a 31.5° route turn, 

 a 78.4° elbow will be generated for a 78.4° route turn. 
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5 DESCRIBING AND EDITING ITEMS 
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5.1 INTRODUCTORY REMARKS TO OBJECT EDITION 

Each object of the ArCADia system, including ArCADia-GAS INSTALLATIONS objects, includes 
properties, or the information on an object’s characteristic parameters: technical, technological and 
geometrical, that are necessary to make supplementary drawings, selective calculations, assess their 
accuracy and generate lists. 
 
An object is inserted in the model by selecting the proper icon on the program toolbar (Błąd! Nie 
można odnaleźć źródła odwołania.).  An object insertion window appears. For each object, the 
window enables to choose its location through defining a handle on its outline or in an object’s 
characteristic point. It also enables entering the object height above the level (e.g. the bottom 
installation level). 
 

By selecting the Import from element  checkbox, the user can insert an object through connecting 
it in a proper point with a connection element of another object that has already been inserted in the 
drawing. 

 
Import from element – If the button is active, clicking an earlier inserted element (such as a vertical 
pipe) will cause its characteristic points of the installation level to be imported and the inserted 
object (such as a valve) to be automatically attached, e.g. to one of the vertical pipe’s ends, on a 
similar level. Examples can be found below:  

 

Drawing 12. A vertical pipeline with ends at the 0 and 200cm installation levels 

For example: It the user has inserted two pipelines at different levels, which intersect in a projection, 

and wants to insert a valve in one of them in the intersection point, it is necessary to activate the 

Import from element button. The object will be attached to the pipeline whose installation level is 

closer to the value typed in the edit box – an example can be found below. 
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Drawing 13. Using the Import from element feature to insert a valve in one of pipelines that 
intersect in the projection. 1a – Two intersecting pipelines that are situated at 50cm and 

100cm, shown in the drawing area, 2b – Inserting a valve in the pipeline situated at 50cm,  
2 – The effect of inserting a valve in the 3D view. 

In this window, there are also options that facilitate the object insertion precision. These options are 
activated through the selection of a proper function of tracking or detecting other objects existing in 
the drawing.  
 
An object can be inserted in a drawing in two ways: 
 

1. Method 1 
The user selects a proper icon from the ArCADia-GAS INSTALLATIONS toolbar and then 

moves to the edition of the object parameters by selecting the  button in the object 
insertion parameters window. An object properties dialog window will be displayed, and it 
will enable to set the object parameters. Once they are set, the user presses OK to return to 
the object insertion window, then clicks a selected location in the drawing area with the 
object symbol, which is attached to the cursor, and finally clicks again while entering the 
object’s rotation angle. Such an insertion procedure causes saving the parameter settings for 
fonts, pens and surfaces for every next object from the same group of elements. 
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Drawing 14. An object insertion window – illustrative views for an object and a pipe 

Tab. 5. The ArCADia-GAS INSTALLATIONS toolbar features 

Icon Description 

 

Changing the location of an object insertion handle. 

 

Moving to the object properties window. 

 

Imports the installation level value from previously inserted objects. For example, 
it allows to automatically connect two gas pipelines with their axes.  

 

The field for entering the installation level above the storey level. 

 

Tracking characteristic elements of objects that have been previously inserted in 
the objects’ drawing area (e.g. tracking pipeline axes).  

 

Detecting objects that have been previously inserted in the drawing area 
(detecting edges or objects’ characteristic elements). 

 

Inserting linear objects with the detection of angles to linear objects inserted 
before in order to connect them at a given angle. The values of angles and the 
accuracy of their detection are set in the Project options window.  

 Inserting 2D and 3D objects, with their rotation on the Z axis. 

 Inserting a selected object at a given distance from a selected point. 

 Inserting an object halfway a selected distance.  

 Inserting an object by a percentage breakdown of a given distance. 

 

2. Method 2 
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The user selects a proper icon from the ArCADia-GAS INSTALLATIONS toolbar (Błąd! Nie 
można odnaleźć źródła odwołania., Błąd! Nie można odnaleźć źródła odwołania.) and 
inserts an object symbol using the snap object tool. After selecting an object, a window is 
displayed with a toolbar that allows to modify the selected object and to give it parameters 
by selecting a given type from the program libraries. Depending on the object type, in the 
modification window there are icons that are characteristic of a specific object. They allow to 
insert proper changes that only regard this object. The number and type of these icons may 
vary for a given object group. 

 

 

Drawing 15. The toolbar to select object modification 

 

Drawing 16. The toolbar to modify a gas pipe 

Icon Description 

 
Move to the object properties dialog window 

 
Font and pen painter  

 
Type painter 

 
Description painter 

 
Edit a description 

 
Set a description on a reference line 

 
Create the real view 

 
Renumber objects 
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Lenghten/Shorten pipe maintaining slope (applies to non-
vertical pipes) 

 

Vertical pipe stretching. This function applies to vertical pipes 
and allows the installation level of the pipeline ends to be 
changed together with the floor change.  

 

 

Move with connections 

Move without connections 

 
Remove selected objects 

 
Access to the project and global libraries 

 

 

 

Functions of selective calculations methods for object types 

intended for automatic selective calculations (e.g. pipelines, cut 

valves, gas filters) relating to technological parameters. 

 

Moving to the object parameter edition can be performed through selecting the  button.  
 
After selecting parameters in the Object properties window and pressing the OK button, the 
parameters of a previously inserted object will be modified. 

 
The Object properties windows are divided into control groups: 
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Drawing 17. The object properties window of an example object  

Each object properties window consists of icons grouped in panels. The panels can be pulled up, 

which hides a particular group. The  button pulls up a panel.  
 
The Object management control group 

Symbol/Type – setting the symbol/type that will be displayed in the projection along with the object 

number. If the user does not insert the change in the active window, the name will be generated in 

the Options window.  

Element id – the number of the consecutive inserted element. 

Type – it enables to insert objects using the main data control, which allows to insert objects from 
the main data library of object types (example objects, e.g. from producer catalogues) and to use the 
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object Type library created while working on the project and containing objects that have been used 
in the project before or moved to the Project library using the Type editor. In this control group it is 
possible to define the user’s own example objects and add them to the Project library.  
Group – it gives the possibility to create groups of objects, e.g. with various purposes, and to select 
them for edition at a later time. 
 

Icon Description 

 

 

The access to the project and global libraries.  

Saving a type to the library of a particular type on the basis  
of the current setting in the properties window. 

 

 

 

Editing the type selection method for objects intended for 
automatic selection (pipelines, cut valves, gas filters) in relation 
to technical parameters. 

 

 

Dropping down the list of object groups of a particular type. 
Adding a new object group of a particular type. 

 
The Appearance control group 
The set of controls in this group is almost identical for all gas objects included in the program. It 
allows to set the general graphic properties of an object.  
In the panel, there is view window for a particular object, with the possibility to change the view 
type. 
 

Icon Description 

 Activating the schematic drawing 

 Activating the projection view 

 Activating the 3D view 

 
Angle – setting the angle of 2D and 3D objects to the main coordinate system.   
Pens – setting the type, thickness and colours of object drawing lines in a view.  
Fonts – setting the font format of the name displayed in projections. 
Surfaces – setting colours and patterns of surfaces shown in the 3D view. 
Description – the controls run the configurator for organising and setting the view and the content of 
a description. 
 
After selecting the checkbox on the left, a button is activated which, in turn, activates the 
configurator window. 
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Drawing 18. The description configurator, the general window 

The user has the possibility to set the substantive contents of description components (various for a 

given object), as well as their order and their location in relation to a description line. 

After pressing the proper button for the line (upper or lower) contents, an additional window is 

displayed which allows for the proper selection of the layout and contents (Drawing 19 – an example 

setting of the bottom line description for a pipeline). 

 

Drawing 19. The description configurator, the setting window  

In the description configurator, there are two tables:  

 On the left side, there are Available components – the available description variants. 

 On the right side, there are Used components – the description variants for a selected line 
that have been used.  
 

Icon Description 

 

Buttons for moving a given description component from the 
Available components window to the Used components 
window. 
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Buttons for ordering descriptions in a row from left to right. 

 

The availability of components for a particular line depends on introducing them into an inactive line. 
Inserting the desired line into the description is done by selecting the name of the description and 
pressing the arrow towards the line description content table. The selected description title will be 
transferred and therefore will not be visible in the Available components table. Should the user wish 
to share the component, he needs to act in a similar manner. He selects the description component 
in the line content table and then uses the left arrow to transfer it to the Available components 
table. The elements of the description sequence in a particular line are set from left to right as per 
the top-down sequence in the line contents table. You can change the sequence by marking a 
component in the line contents table and controlling the sequence change buttons, which causes the 
sequence of a particular component to be changed by one field. Each use of the arrow moves the 
item one field up or down. The changes will be applied after pressing the Close button. 

The Parameters control group 
This is a set of individual controls for each object. It allows the user to set the defining installation 
parameters, for example the item location, its functions, etc. 
Additional equipment – a button opening a table where the user insert additional equipment whose 
elements should be included in the material lists, is available for some objects. It is also possible to 
insert any object name in the edit field. 

 

Drawing 20. The additional equipment window 

The  button may be used to add a relevant item from the drop-down list. At the same time, the 

user can insert their description into a table cell, changing the unit and quantity. The  button 

removes a selected item. The  and arrows change the sequence of the selected element 
position. 
 
The Type parameters control group 
This is a set of individual controls for each item. It allows the user to set the parameters that specify a 
particular object, for example technical or geometric parameters, or an object description. 
Additional description – the user can insert custom information, which may appear in drawing 
descriptions and material lists. 
The window settings ending controls 
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  – This function allows for saving the type parameters of a defined object and, using 
the arrow, for choosing the name of a template in which the object will be saved. 

 – Restoring the initial settings. 

 – Leaving the window and confirming the object properties settings.  

 – Leaving the window and cancelling the object properties settings.  
 

5.2 A GAS BOX 

To insert a Gas box into a model, select the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group   

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    

or type: 

 IGAS_GC. 

An object insertion window is displayed: 

 

Drawing 21. The Gas box insertion window 

The window allows the user to set the appropriate box insertion position by: 

 Setting the box bottom installation level – the  button allows the user to adjust the 

bottom height to the existing element (e.g. a pipeline). The user has to give an approximate 

height, especially when there are various elements at various heights in a given place. The 

installation level can be typed manually in the edit box. 

 Selecting a handle on the box’s outline or the middle point by clicking one of the nine 

possible points. 
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 Selecting the insertion relevant to the already drawn elements feature, i.e. setting the 

elements detection, elements tracking, sections detection and section ends tracking 

features. 

The user can also give an approximate value of the connection level, which allows to find an object 
on the most similar level and to connect the box’s bottom with the object’s point that is on the most 
similar level.  
 
The Import from element feature should only be used after selecting the Element and section 
detection button. 

 
The window also allows the user to use the Project library. The user can select an example type of a 

gas box from the drop-down list of the Project library and use it in the project. When the gas box 

insertion window is active, a box symbol shows up on the model's drawing area (projection).  Clicking 

a chosen spot inside the drawing area inserts the object. Another clicking sets the gas box insertion 

angle to existing elements.  

The gas box properties editing window is displayed after selecting the  button or double-

clicking the inserted element (Drawing 22). 

 

Drawing 22. The Gas box properties window 

In the gas box properties window the user can adjust the appearance of the object in the projection, 

as well as the installation and technical parameters necessary to execute the further calculations. 

The Parameters control group  
 
It allows the user to set the fitting and technical parameters of a gas box as the beginning of a gas 
installation. 
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 After checking the Main gas box checkbox, the Main gas box button becomes active. After 
pressing it, a window to set the pressure parameters behind the gas box is displayed. The 
user has the possibility to decrease the pressure behind the gas box, compared to the 
pressure before the gas box, while taking into consideration the anticipated pressure losses 
on the gas box equipment elements. Additionally, giving it the function of the main gas box 
enables to connect it with objects and elements coming from the ArCADia-EXTERNAL GAS 
INSTALLATIONS module and becomes the component to combine the interior and exterior 
installation projects.  

 
If the user inserts this gas box into a building (without connecting any objects), and then he inserts 
objects coming from the ArCADia-EXTERIOR GAS INSTALLATION module, it will be possible to 
connect the exterior gas installation pipes and, at the same time, to give the flow or check the  
Calculate gas flow checkbox. 
 

 

Drawing 23. The window to set the pressure parameters for the main gas box  
 

NOTE! If the main gas box is connected with the receivers with pipelines, the Gas flow field is not active. 

Another two buttons, , let the user to select the installation (gas fuel), 

in which a given box will be mounted. If the user has a few types of fuel added in the project options, 

after a click, the list of available types of gas fuel will drop down . Next to it, 

the  button to move to Gas fuel properties is situated. After entering the properties, it is possible 

to review or to change basic installation parameters (gas fuel, velocity criterions, permissible 

pressure losses).  

The Type parameters control group  

Standard/Producer – They are imported from the Type library or typed by the user in order to define 
a new object type. 
DN diameter – It is imported from the Type library or typed by the user to define a new object type. 
Type/Series type – they are imported from the Type library or inserted by the user in order to define 
a new object type. 
Width/Depth/Height – Edit boxes in which it is possible to give a gas box appropriate dimensions. 
If a gas box has already been inserted, the user clicks on it to have the object modification window 

available.  
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Drawing 24. The Gas box modification toolbar 

5.3 A GAS APPLIANCE 

To insert a Gas appliance into a model, select the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group    

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    
 

or type  
 

 GAS_GR. 
 

 

Drawing 25. The Gas appliance insertion window 

The window allows the user to set the appropriate gas appliance insertion position by: 

 Setting the gas appliance’s ending’s installation level – the  button allows the user to 

adjust the bottom height to the existing element (e.g. a pipeline). The user has to give an 

approximate height, especially when there are various elements at various heights in a given 

place. The installation level can be typed manually in the edit box. 

 Selecting a handle on the gas appliance’s outline or the middle point by clicking one of the 

nine possible points. 

 Selecting the insertion relevant to the already drawn elements feature, i.e. setting the 

elements detection, elements tracking, sections detection and section ends tracking 

features. 
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The user can also give an approximate value of the connection level, which allows to find an object 
on the most similar level and to connect the appliance’s ending with the object’s point that is on the 
most similar level.  
 
The Import from element feature should only be used after selecting the Element and section 
detection button.  

The gas appliance properties editing window is displayed after selecting the  button or 
double-clicking the inserted element. 
 

 

Drawing 26. The Gas appliance properties window 

The Parameters control group 
Simultaneity group is an editable drop-down list, which enables the user to insert the designation of 
a simultaneity group for a given gas appliance. Appliances of the same simultaneity constitute a set 
of devices that might work simultaneously with high probability. 
For a gas pipeline section, the program calculates the simultaneous fuel consumption coefficient, 
based on the number of fuelled groups. 
Device bottom installation level is the device bottom installation distance from the reference level 
(the reference level is the level of the active storey, taken as 0cm). 
Upstream gas pressure is the minimum and maximum gas pressure that may appear in the 
installation before a gas appliance. 
Additional equipment – The user can insert here additional elements that should appear in the list, 
e.g. an elastic pipe connector. 
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Device power/Gas consumption – In this edit box, the user enters the value of the heat output of 
the gas appliance in kW. The value is entered based on the device specifications or literature data. 
Optionally, after switching the radio button, the user can enter gas consumption. Depending on the 
used gas heating value (setting gas parameters), the values are calculated.  
 
The Type parameters control group 
Equipment purpose – From the drop-down list, the user selects a group of devices due to their use. 
The devices are divided as follows: for domestic and gastronomic use, for domestic hot water, as well 
as for heating and technological use (any other devices with individual technological or heating use).  
Device type – The selection from the drop-down list depends on the selection of the item from the 
Equipment purpose list. The user chooses the device due to its function. 
Standard/Producer – They are taken from the Type library or entered by the user to define a new 
object type. 
Type/Series type – They are taken from the Type library or entered by the user to define a new 
object type. 
Connection type – It is taken from the drop-down list. 
Endings material – It is taken from the Type library or entered by the user to define a new object 
type. 
DN branch diameter – The nominal diameter of the ending of the gas appliance’s connection to the 
gas installation. It is selected from the editable drop-down list. The value is entered based on the 
device specifications or literature data. 
Geometric parameters (width, depth, height) – They are taken from the Type library or entered by 
the user to define a new object type. 
Connector to bottom height – It is taken from the Type library or entered by the user to define a 
new object type. (When connecting the installation pipeline with the appliance parameters 
download function active, specifying the connection height will enable the pipeline to be turned on 
by clicking on any point on the object outline.) 
Additional description – It is taken from the Type library or entered by the user to define a new 
object type. 

5.4 A GAS VALVE 

To insert a Gas valve into a model, select the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group   

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar The Gas installations toolbar   

 
or type  

 

 IGAS_GV. 
 
An object insertion window is displayed (Drawing 27). A valve is always inserted into a projection 

with a handle located in the middle of its symbol. 
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Drawing 27. The Gas valve insertion window 

The window allows the user to set the appropriate gas valve insertion position by: 
 

 Setting the valve installation level: The  button allows the user to adjust the bottom height 

to an existing element (e.g. a pipeline). It is necessary to enter the approximate height, 

especially if there are several elements at different heights in a given location. The 

installation height can be entered manually in the edit box. 

 Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features. 

 The user can enter the approximate value of the connection height, which allows to locate 

the closest element (object) and to connect the valve to the object’s point which is closest 

and situated at the most similar height.  

 The  icon indicates a certain state of the object regarding the calculations being made. 

After clicking this icon, it is possible to change the status according to one of the three 

options: 

 

 Set type – With this option selected, the user can set the type for the selected element (the 

field with the Type library is unlocked). 

 Selection from selected catalogues – With this option selected, the elements are taken from 

the catalogues selected in the Project options.  

 Selection from set catalogue – With this option selected, the catalogue selection box is 

unlocked. The user can choose one of the catalogues from the Project library and the object 

will be selected from it, regardless of the settings in the Project options. 
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The Import from element function should be used with the Element and section detection function selected.  

The gas valve properties editing window is displayed by selecting the  button or double-

clicking the inserted element. 

 

 

Drawing 28. The Gas valve properties window 

The Object management control group 
 
Type – This control allows the user to enter objects using the Project library. In addition, the valve 

has the  button for choosing the type selection method. This means that the program can 
automatically select the valve. 
 
The Parameters control group  

Axis installation level – The user enters the installation level of the valve axis in the edit box.  

The Type parameters control group  
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Name – It is imported from the Type library or entered manually by the user in order to define a new 
object type. 
Standard/Producer – They are imported from the Type library or typed by the user in order to define 
a new object type. 
Type/Series type – They are taken from the Type library or entered by the user to define a new 
object type. 
Connection type – It is taken from the drop-down list. 
Endings material – It is taken from the Type library or entered by the user to define a new object 
type. 
DN diameter – The nominal diameter of the ending of the gas appliance’s connection to the gas 
installation. It is selected from the editable drop-down list. The value is entered based on the device 
specifications or literature data. If the Automatically checkbox next to the diameter is unchecked 
(the parameter is set by default), the selection of the valve diameter is blocked and the valve’s 
diameter is set as equal to the diameter of the pipeline in which it is inserted. 
Additional description – It is taken from the Type library or entered by the user to define a new 
object type. 

5.5 GAS METER 

To insert a Gas meter into a model, click the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group    
 

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    
 

or type  
 

 IGAS_GV. 
 

An object insertion window is displayed (Drawing 29). 

 

 

Drawing 29. The Gas meter properties window 

The window allows the user to set the appropriate gas meter insertion position by: 

 Setting the gas meter installation level: The installation level can be entered manually in the 

edit box. 
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 Using the  gas meter ending selection button when inserting into the drawing area. 

 Using the  button, which allows the user to adjust the endings’ height to an existing 

element (e.g. a pipeline). It is necessary to enter the approximate height, especially if there 

are several elements at different heights in a given location.  

 Selecting a handle at the place of the defined connection endings of the gas meter (left or 

right ending). 

 Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features. 

The window also allows the use of the Project library. From the drop-down list of a given library, the 
user can choose an illustrative type of a gas meter. When the gas meter insertion window is active, a 
gas meter symbol appears in the model drawing area (projection). Clicking a selected place in the 
drawing area inserts the object. Then, the user can rotate the gas meter about one of the endings to 
get the correct insertion angle and click again. 

The gas meter properties editing window is displayed by selecting the  button or double-

clicking the inserted element.  

 

Drawing 30. The Gas meter properties window 

 

The Parameters control group 
Setting the gas meter installation and technological parameters. 
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Gas meter bottom installation level – The user inserts the gas meter installation height counting 
from the floor level to the gas meter bottom. 
Max. calculation pressure loss – Based on technical (trade catalogue) knowledge, the user enters the 
maximum calculation pressure loss.  
 
The Type parameters control group 

Name – It is imported from the Type library or entered manually by the user in order to define a new 
object type. The name is editable and the user can enter his own. Additionally, the drop-down list 
includes a few types of the most often used gas meters. 
Standard/Producer – They are imported from the Type library or entered by the user in order to 
define a new object type. 
Type/Series type – They are taken from the Type library or entered by the user to define a new 
object type. The type is editable and the user can enter his own. Additionally, the drop-down list 
includes a few types of the most often used gas meters. 
Connection type – It is taken from the drop-down list. 
Endings material – It is taken from the Type library or entered by the user to define a new object 
type. 
Gas meter connector spacing – It is taken from the Type library or entered by the user to define a 
new object type. 
DN branch diameter – The nominal diameter of the ending of the gas appliance’s connection to the 
gas installation. It is selected from the editable drop-down list.  
Gas meter connector height from bottom – The level difference between the bottom of the gas 
meter and the connections. 
Geometric parameters (width, depth, height) – They are taken from the Type library or entered by 
the user to define a new object type. 
Additional description – It is taken from the Type library or entered by the user to define a new 
object type.  
 

5.6 GAS FILTER 

To insert a Gas filter into a model, click the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group   
 
The AutoCAD or INTERsoft-INTELLICAD software:  

 

 The Gas installations toolbar    
 

or type  
 

 IGAS_GF. 
 

An object insertion window is displayed (Drawing 31). 
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Drawing 31. The Gas filter properties window 

The window allows the user to set the appropriate gas filter insertion position by: 

 Setting the gas filter installation level: It is possible to enter the installation level manually in 

the edit box, The  button allows the user to adjust the height to an existing element (e.g. a 

pipeline). It is necessary to enter an approximate height, especially if there are several 

elements at different heights in a given location.  

 Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features. 

The  icon indicates a certain state of the object regarding the calculations being made. After 

clicking this icon, it is possible to change the status according to one of the three options: 

 

 
 

 Set type – With this option selected, the user can set the type for the selected element 

(the field with the Type library is unlocked). 

 Selection from selected catalogues – With this option selected, the elements are taken 

from the catalogues selected in the Project options.  

 Selection from set catalogue – With this option selected, the catalogue selection box is 

unlocked. The user can choose one of the catalogues from the Project library and the 

object will be selected from it, regardless of the settings in the Project options. 
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The Import from element function should be used with the Element and section detection function selected.  

The window also allows the use of the Project library. From the drop-down list of a given library, the 
user can choose an illustrative type of a gas filter and use it in the project. 

The gas filter properties editing window is displayed by selecting the  button or double-

clicking the inserted element.  

 

Drawing 32. The Gas filter properties window 

Type – This control allows the user to enter objects using the Project library. In addition, the filter 

has the  button for choosing the type selection method. This means that the program can 
automatically select the filter. 
 
The Parameters control group 
Setting the gas filter installation and technological parameters. 
Axis installation level – The user inserts the gas filter installation height counting from the floor level 
to the gas filter axis. 
Max. calculation pressure loss – Based on technical (trade catalogue) knowledge, the user enters the 
maximum calculation pressure loss.  
 
The Type parameters control group 
Name – It is imported from the Type library or entered manually by the user in order to define a new 
object type. 
Standard/Producer – They are imported from the Type library or entered by the user in order to 
define a new object type. 
Series type – It is are taken from the Type library or entered by the user to define a new object type. 
Connection type – It is taken from the drop-down list. 
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Endings material – It is taken from the Type library or entered by the user to define a new object 
type. 
DN diameter – The nominal diameter of the ending of the gas appliance’s connection to the gas 
installation. The value is entered based on the device specifications or literature data. If the 
Automatically checkbox next to the diameter is checked (the parameter is set by default), the 
selection of the filter diameter is blocked and the filter’s diameter is set as equal to the diameter of 
the pipeline in which it is inserted. 
Row/Output – They are taken from the Type library or entered by the user to define a new object 
type. 
Additional description – It is taken from the Type library or entered by the user to define a new 
object type. 

5.7 PRESSURE REDUCER 

To insert a Pressure reducer into a model, click the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group    
 

The AutoCAD or INTERsoft-INTELLICAD software:  

 

 The Gas installations toolbar    
 

or type  
 

 IGAS_GRD. 
 

An object insertion window is displayed (Drawing 33). 
 

 

Drawing 33. The Pressure reducer properties window 

The window allows the user to set the appropriate pressure reducer insertion position by: 

 Setting the pressure reducer installation level: It is possible to enter the installation level 

manually in the edit box. The  button allows the user to adjust the height to an existing 

element (e.g. a pipeline). It is necessary to enter an approximate height, especially if there 

are several elements at different heights in a given location.  
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 Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features. 

The window also allows the use of the Project library. From the drop-down list of a given library, the 
user can choose an illustrative type of a pressure reducer and use in the project 

The pressure reducer properties editing window is displayed by selecting the  button or 
double-clicking the inserted element.  
 

 

Drawing 34. The Pressure reducer properties window 

 
The Parameters control group 
Setting the pressure reducer installation and technological parameters. 
Axis installation level – The user inserts the pressure reducer installation height counting from the 
floor level to the pressure reducer axis [cm]. 
Required outlet pressure – Based on technical knowledge, the user enters the outlet pressure 
required for the installation, from the range of outlet pressures entered in the type parameters, in 
kPa. 
 
Grupa kontrolek Parametry Typu 
Name – It is imported from the Type library or entered manually by the user in order to define a new 
object type. 
Standard/Producer – They are imported from the Type library or entered by the user in order to 
define a new object type. 
Series type – It is are taken from the Type library or entered by the user to define a new object type. 
Inlet/Outlet – The lower part of Type parameters is divided into the inlet and outlet of the reducer. 
Connection type – It is selected from the drop-down list. 
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Ending material – It is imported from the Type library or entered by the user in order to define a 
new object type. 
 
NOTE! The connection type and ending material may differ for the reducer inlet and outlet. To enter different 

parameters on either side, click the  padlock to set it in the open position . 

DN diameter – The nominal diameter of the connection ending to the gas installation, [mm]. It is 
selected from the editable drop-down list.  
Pressure range –  Min., Max. – The range is taken from the Type library or entered by the user, 
[kPa]. 
Row/Output – They are taken from the Type library or entered by the user to define a new object 
type, [m3/h]. 
Additional description – It is taken from the Type library or entered by the user to define a new 
object type. 

5.8 VERTICAL GAS PIPE 

To insert horizontal distribution pipelines and connecting pipes, click the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group   
 

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    
 

or type  
 

 IGAS_GP. 
 
The pipe insertion window is then displayed. The pipeline is inserted in two stages, divided into the 
beginning and the end of the pipeline. 
 
As in previous cases, by unchecking the appropriate check box, the tracking and detecting functions 
of previously drawn objects are activated. 
 
Pipeline insertion procedures are determined by the appropriate function setting in the gas pipe 
insertion window. 
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Drawing 35. The view of the horizontal gas pipe insertion window – insertion of the first point 

 

Drawing 36. The view of the horizontal gas pipe insertion window – insertion of the second point 

Icon Description 

 

Parallel offset (e.g. off a wall) 

 

Setting the offset direction and value 

 
Automatic switch-over from a horizontal pipeline to 
drawing a vertical section 

 
Having selected the pipeline insertion icon from the toolbar, the user can insert the first point of the 
gas pipe. After clicking in the drawing area, the beginning of the pipeline is inserted and another 
window is opened to insert the end of the pipeline. After entering the value of the axis installation 
height for the second point of the pipeline, the user clicks in the drawing area while inserting the 
pipe section. 
 

 If the user wants to insert a pipeline with a specific slope, he selects the Slope button and 

enters the slope value, [%]. If the user wants the end of the pipeline to be higher than the 

beginning, he enters the slope with the “–“ sign.  

 The Import from element checkboxes give the possibility to attach pipeline sections to the 

previously drawn elements. 

 The  icon indicates a certain state of the object regarding the calculations being made. 

After clicking this icon, it is possible to change the status according to one of the three 

options: 
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 Set type – With this option selected, the user can set the type for the selected element 

(the field with the Type library is unlocked). 

 Selection from selected catalogues – With this option selected, the elements are taken 

from the catalogues selected in the Project options.  

 Selection from set catalogue – With this option selected, the catalogue selection box is 

unlocked. The user can choose one of the catalogues from the Project library and the 

object will be selected from it, regardless of the settings in the Project options. 

 

 
 
Additionally, there is a possibility to insert a gas pipeline using the so-called continuous route. To do 
it, click the icon: 
 
The ArCADia software:  

 The Gas ribbon  The Gas installations logical group    

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    
 

or type  
 

 IGAS_GPR. 
 
The tool enables to insert a few sections of various directions in a continuous way, with the heights 
of the beginning of the first section and the ending of the last sections set. 

5.8.1 Odsunięcie równoległe 

In the horizontal pipeline insertion windows, there is also the Parallel offset function , (Drawing 
35), available. Selecting this function allows the user to draw a pipeline offset by a given distance, 
e.g. from another installation or a wall surface line. It is possible to set an offset value in the edit box 
in the insertion insert window and to indicate the direction of the pipeline offset using  and . 

5.8.2 Wstaw pionowy odcinek 

During the horizontal gas pipelines insertion, without interrupting the command, vertical sections of 

the installation can be inserted too. When drawing, after clicking the next point, e.g. the end of a 
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horizontal pipeline (which will also be the beginning of a vertical pipeline), press the  Insert 

vertical section button and enter the height of the end of the vertical section. After clicking, the user 

can continue entering further horizontal sections.  

The gas pipe properties editing window is displayed by selecting the  button or double-clicking 
the inserted element.  
 

 

Drawing 37. The Gas pipe properties window 

The Parameters control group 
Axis installation level; Beginning, End – This edit box gives the possibility of entering the appropriate 
heights of the beginning and end of the pipeline. 
Length on the projection – The pipeline length that the pipeline takes up on the projection. 
Actual length – The value of the pipeline length that the pipeline actually takes in while taking into 
account the slope. If the Automatically checkbox is selected, the actual lengths calculated by the 
program will be included in the bill of materials. After deselecting the checkbox, the user can enter 
any length of the pipeline and this value will be included in the bill of materials.  
Laying method – From the drop-down list the user can choose the laying method: 

 Plaster surface, 

 Plaster flush, 

 In channel/service space, 

 In sling/brackets. 
 
The Type parameters control group 
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Material – It is imported from the Type library or entered by the user in order to define a new object 
type. 
Standard/Manufacturer – They are imported from the Type library or entered by the user in order 
to define a new object type. 
Type/Series type – They are taken from the Type library or entered by the user to define a new 
object type. 
Connection type – It is selected form the drop-down list. 
Outside diameter – It is imported from the Type library or entered by the user in order to define a 
new object type. 
Wall thickness – It is imported from the Type library or entered by the user in order to define a new 
object type. 
DN diameter – It is imported from the Type library or entered by the user in order to define a new 
object type. 
Roughness factor – Its default value is set for steel pipelines (k = 0.045mm). The user can set a 
different value: 

 for copper pipelines k = 0.0015mm, 

 for polyethylene pipelines k = 0.007mm. 

Additional description – It is imported from the Type library or entered by the user in order to 

define a new object type. 

NOTE! When inserting pipelines, it is recommended to select their types from the libraries contained in the 
project. After selecting a given type, the parameter boxes are filled in automatically. 

 

 

Drawing 38. The Gas pipe properties window 

An additional modifying function is the possibility of lengthening or shortening the pipe while 

maintaining a slope.  – Shorten/lengthen pipe maintaining slope. 

The  Insert fittings function allows the user to generate symbols of fittings that were used to 
create a connection. After clicking on the circle of fittings, a window opens that allows checking and 
editing the connection type. 
 
After selecting the Horizontal pipe object and after choosing the icon shown on the figure above, the 
user clicks on a chosen end of a pipe and drags the marker in a chosen direction along the pipeline 
axis or along the pipeline axis trace. 

5.9 VERTICAL GAS PIPE 

To insert vertical distribution gas pipelines (risers) and vertical receiver connections, click the icon: 
 
The ArCADia software:  
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 The Gas ribbon  the Gas installations logical group   

The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    
 

or type  
 

 IGAS_VGP. 
 
The window to insert vertical pipes is displayed. As in previous cases, by unchecking the appropriate 
checkbox, the tracking and detection functions of previously drawn objects are activated. 
 
Pipeline insertion procedures are determined by the appropriate function setting in the vertical gas 
pipe insertion window.  

 

Drawing 39. The Vertical gas pipe insertion window with the feature drawing with height import 
from the active level 

 – Import from below level 

 – Import from above level 

 

Drawing 40. The Horizontal gas pipe insertion window with height import from drawn elements 

 – Import from element 

Inserting a "vertical" pipeline with the manual value entry feature consists in the user entering the 
starting and ending height of a section in the editing fields.  
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Inserting a "vertical" pipeline with the import height from the level activated for the drawing feature 
allows "punching" the pipeline through building ceilings. A trace (the so-called reference) of the 
vertical pipe is plotted in the projections of the levels below or above the level where the pipe is 
inserted. You can continue drawing the riser in the level above from this trace. 
 
The Import from element fields allow the user to add pipeline sections to the points of previously 
drawn elements. For this method, inserting is done in the same way as in the case of horizontal 
pipes. 
 

The designed gas pipeline section properties defining window is displayed by selecting the 
button or double-clicking the inserted vertical pipe section. The window and the functions are the 
same as in the case of a horizontal pipe. The only difference is the lack of drop (vertical pipe). 
 
The Extend pipe icon is located in the vertical gas pipe modification window. 
       

 

Drawing 41. Vertical pipe modification window view 

After the user selects this function, a window appears that allows for changing the position of the 
vertical pipeline endings with the option of selecting the level on which the pipeline beginning and 
ending will be located. Below is an example of a vertical pipe extension and a 3D visualisation. 
 

 

Drawing 42. Vertical pipe extension window 
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Drawing 43. Stack 3D view stretched onto other levels using the Expand stack function. 

 

5.10 EDITING AND ENTERING TYPES 

 

To display the Type library editor window, click the icon: 

The ArCADia software:  

 The System ribbon  The Libraries  logical group    

The AutoCAD or INTERsoft-INTELLICAD software: 

 The ArCADia-SYSTEM toolbar    

or type 

 ISA_ETL. 

The Type library editor is used to edit and introduce new item types into the ArCADia software. It 

facilitates access to manufacturers catalogues and enables selecting only those catalogues which the 

user uses most often when designing. Additionally, types are divided into the Standard library (i.e. 
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the library provided with a given software version) and the User library, where all the new or user-

modified element types are saved. 

 
 

Drawing 44. The Type library editor window 

In the upper part of the type editor window (Drawing 44) the user has the possibility to select a 

branch  

from the drop-down list where all the branch-modules available in ArCADia are listed. 

 
 

Drawing 45. The drop-down list of branches available in the ArCADia system  

After selecting the desired branch, the user as access to all the objects available in the selected 
branch (module), e.g. a drainage pipe (Drawing 47). 
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Drawing 46. The list of objects available in gas installations in the ArCADia system 

After clicking on a selected item, all types of items will be available in the Global library. On the first 

launch of the program, these will be the Standard library types (files included with a given program 

version). During the design process, it is possible to add additional types to create the User library. 

 

Drawing 47. The Type library editor window after selecting a desired branch and one of its objects 

 
The lower part of the editor window is divided into the Global library side (on the left) and the 

Project library side (on the right). 

The Global library is the place where all types of objects available to the user are added by default, 

and during the work with the program they are divided into the Standard library (not changed by the 

user and attached to a given software version) and the User library, which contains elements (types) 

entered by the user while working with the program. 
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The Project library is the place where all types of objects used in the project or available for use can 

be found. A type can be given to an element from the element properties window (Drawing 48, 

Drawing 49): 

 

Drawing 48. Type insertion point from the object properties level and in the modification and 
insertion window 

  
 

Drawing 49. Type insertion point from the object modification and insertion window level 

 

Add new type  – after clicking this icon the user has the possibility to add a new type to the Global 

library or the Project library (to the User library). It is also possible to edit type properties for the 

particular element, where the user may determine all the element’s characteristic parameters, 

including type parameters, view. 

NOTE! Clicking the Add new type icon when a type has been previously highlighted in the library will add a new 
type based on the highlighted one. This facilitates entering a catalogue of items to the library, e.g. supplied by one 
company, where the only distinctive feature is e.g. the diameter. 

Add new folder  – After clicking this icon, the user can add a new folder, to which he will then be 

able to add object types. A window will appear with the option of entering the folder name. After 

typing the name, the user presses the  button to add the folder to the library or 

 to abort the command. 
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Drawing 50. The inserted type folder window 

Delete  – after clicking this icon the user may delete the selected type or folder. 

Type properties  – after clicking this icon the user will have access to the properties of the 

selected type. These values can be edited and saved here.  

Leave only the types used in the project  – after clicking this icon in the Project library, only the 

types used in the project (in any object) will remain visible. 

After clicking a type with the right mouse button, a menu becomes available: 

 
Type properties – works in the same way as the icon described above. 

Copy – copies the type. 

Paste – pastes a previously copied type and inserts it with the same name and subsequent number. 

Rename – the user may rename an already inserted type. 

Delete – works in the same way as the icon described above. 

The  button is located above the project library. Once you click this button, 

the Project library settings will be saved in the template and will be accessible for future projects 

using this template. Next to it there is an  icon – when clicked, it provides the user with a list of 

available templates. 
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Drawing 51. An illustrative properties window 

 
In the Project library window it is also possible to check which types of a given object are currently 

used in the project; the symbol is displayed to the left of such a type name.  

 

Drawing 52. The Type library editor window after entering a type in the Project library 

The following icons are available below the two libraries: 

Hide everything . After clicking the same icon the types tree in a given library will be hidden down 
to the main catalogues. 
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Extend everything  After clicking this icon, the type tree in a given library will be extended. 

The user may also search the library by typing a part or the entire name of the desired type in the 

 field. The  button is located next to the field. After 
clicking the button, the editing search field will be cleared.  

After selecting types or folders, the transfer buttons located between the libraries are activated. 

Copy all to the project library  – copies the entire global library content to the project library. 

Copy to the project library  – copies the selected elements to the project library. 

Copy to the global library  – copies the selected elements to the global library. 

Copy all to the global library  – copies the entire project library content of the selected element 
to the global library. 

Messages that may be displayed when working with the Type library editor: 

1. This message informs that a type with this name already exists. After clicking the 

button, the data contained in the new type will be saved and will replace the 
data contained in the previously existing type.  

 

 

2. This message informs that the types the user selected will be deleted. The  
button confirms deleting types. 

 

 
 

3. This message informs that the Project library layout has been saved to the project template, 
e.g. Standard. 
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NOTE! If the user has made any changes in the Project library while working with the project, modified existing 
types or expanded the library by adding new types, the new types will become available for future projects. The 
user should add the new types to the Global library using the transfer buttons. 
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6 SELECTIVE CALCULATIONS OF ELEMENTS 
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6.1 GENERAL ASSUMPTIONS FOR AUTOMATIC SELECTION MADE BY THE 

SOFTWARE 

The designer will find it extremely useful when carrying out process calculations that technical 

parameters of the main elements in the gas installation can be automatically selected by the 

software. 

Objects which have their parameters selected are: 

 internal gas installation pipelines 

 internal gas installation stop valves 

 internal gas installation gas filter. 

The selection of items was configured in a manner ensuring that all the borderline conditions 

determined by the user are met, i.e. conditions for minimum and maximum velocity for design flows 

in pipelines, permissible unit gas pressure loss and permissible total gas pressure loss. 

If the pressure upstream of the receiver is lower than the minimum pressure defined for a given 

receiver, the user will see the following message: Minimum pressure not met upstream of the 

receiver ODB1 (1.59kPa < 1.6kPa). 

If the maximum pressure upstream of the receiver is exceeded, the user will see the following 

message: Maximum pressure exceeded upstream of the receiver ODB1 (4.99kPa < 2.50kPa). 

6.2 INTRODUCING ITEMS MEANT FOR SELECTION 

At the beginning the user must input into the Project library the types of items they will use in the 

project, i.e. they select entire catalogues from the pipes and appliances database or select only 

specific series of type. This is done via the Type library editor . From among the selected 

catalogues the software will select the appropriate item types that meet all the borderline 

conditions, both for the item, as well as globally. 

Each item meant for automatic selection is introduced by defining the state of its technical 

parameters. In the item insertion window and in the properties window in the Item management 

part you will find a button to extend the selection window – Type selection method. 
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Drawing 53. Parameter selection method switching window – selection method for Set type 

After pressing the button a list containing three methods of setting the parameter selection method 

is extended.  

Set type – in this method the users determines the type of an item, i.e. selects exactly one item. 

Selecting this method activates the Project library button, which allows extending the list. From a list 

of item types the user selects one item type (one pipeline). After starting automatic selection this 

item will be included in the calculations, however it will not change its parameters and will not be 

replaced, even if it does not meet the selection criteria. This way the user “freezes” the item.  

Selection from selected catalogues – this method is the default for each item. This involves the full 

range of item selection.  

 

Drawing 54. Parameter selection method switching window,  
selection method for Selection from selected catalogues 

The Project libraries lists are greyed out. Parameters are selected from the catalogue of items 

selected in the Selection options, which is activated with the button from the toolbar. 
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Selection from set catalogue – this selection feature enables selecting an item from a single pre-

determined catalogue, independent of the catalogues selected in the options. 

 

Drawing 55. Type selection method switching window – the Selection  
from set catalogue method 

This method of selection enables the user to automatically select a type of item from a particular 
catalogue. In the case of pipelines, when using this selection option the user may ensure that a 
section will be made of steel, regardless of the entire installation be made of pipes of a different 
material. Only the section diameter will be selected then, with the pre-determined material and 
series of type. 

6.3 STARTING THE SELECTIVE CALCULATIONS OF ELEMENTS AND SETTING THE 

OPTIONS OF SELECTIVE CALCULATIONS 

After drawing the installation and checking the correctness of the connections, the user can run the 

selective calculations of pipelines and fittings. To start Installation item selection, click the icon: 

The ArCADia software:  

 The Gas ribbon  the Gas installations logical group   
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The AutoCAD or INTERsoft-INTELLICAD software:  

 The Gas installations toolbar    

or type  

 IGAS_MAT. 

6.4 SELECTION CRITERIA DETERMINATION 

Once the icon is pressed, the following selection options window is activated: 

 

Drawing 56. Selection options window – determining selection criteria 

Before pressing OK the user may use the default selection criteria or input their own item selection 
criteria. The basic criteria determined by the user are the velocity in the pipelines and permissible 
pressure losses: total and unit. 
 

Should the user make a full selection of pipelines or other items, they must indicate the catalogues or 

items for selection from the Project library. 
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Drawing 57. Matching options window, selection of element types for matching 

Once a particular group of items is selected (e.g. Gas pipe), the user may add catalogues by 
marking the selected ones. To select another catalogue of types, a new item needs to be added 

by clicking . 
After setting all the items included in a project and pressing the Match button, an item will be 
selected. 
 
The user may preview calculations in the calculations table, where he can introduce the 
necessary corrections. 
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7 CALCULATIONS AND RESULT INTERPRETATION 
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7.1 VERIFYING THE VALIDITY OF A DRAWN INSTALLATION 

After an installation is drawn you can verify the design for connections between pipelines and 
connections between the installation and the main gas box and receivers. To start the installation 
verification feature, click the following icon in the software toolbar: 
 
ArCADia software:  

 Gas ribbon  Gas installations logical group    

AutoCAD or INTERsoft-INTELLICAD software:  

 Gas installations toolbar    
 

or write  
 

 IGAS_VER. 
 
The table contains information concerning the number of discontinuities in the installation. The 
program detects elements of the installation that are not connected or pipeline sections that are not 
connected to a gas box or receiver. 
 
After clicking the error information, the user will activate the drawing error detection feature. The 
software will highlight the routes and elements where errors occur. The designer can correct the 
drawing by connecting elements in order to ensure continuity of the installation. After the 
corrections are implemented, the software will prepare a report informing the user about the validity 
of the designed installation. 
 
In the left part of the window the user may filter errors and display only the selected descriptions. 
The user may select the main gas box from the previously added items in the Installation drop-down 
list. The user may limit the range of errors displayed for a particular level in the Placement drop-
down list. The Elements drop-down list gives the user the possibility to choose one of the several 
element groups that were not connected. If there are connection errors in receiver or valves groups, 
the user may select e.g. only the valves. From the Category drop-down list the user selects the error 
type that occurs in the project: unconnected elements, faulty connection. 
 
After selecting from the drop-down lists the user can select the items that are not connected and 
that have been assigned to a particular grouping in the drawing. To do that, press the Show selected 
button. The installation projection view area will then be moved to the particular part of the 
installation drawing that includes the group of connection errors and the erroneously connected 
elements will be marked with dotted lines with the handles visible. 
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Drawing 58. Table – Designed installation validity gas installation report 

Message types (message icons differ): 

 Information  

 Warning  

 Error  
 

Message content - Interpretation 

1. The installation design is correct 
The message appears when there is a main gas box present in the installation and all the 
items which are directly or indirectly connected to that point are creating an installation that 
is correctly designed in terms of connections. 

2. Unconnected pipeline 
The message appears when there is an unconnected pipeline in the project.  

3. Unconnected items: e.g. Gas valve ZG2 
The message appears when an item is not connected to any pipeline. 

4. Item unconnected to any path: Receiver ODB2 
The message appears when an item (also a pipeline) is not directly or indirectly connected to 
the main gas box. (It can be connected to the pipelines, although these pipelines are not 
connected to the box). 
 

7.2 CALCULATIONS  

After verifying the validity of the installation model created and selecting diameters, you can carry 
out calculations. In order to do that press the following icon in the software toolbar: 
 
ArCADia software:  
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 Gas ribbon  Gas installations logical group   

 

AutoCAD or INTERsoft-INTELLICAD software:  

 Gas installations toolbar    

or write  

 IGAS_CALC. 

Then a calculation table window appears. The window includes two tables. 

The top table is used to select the calculation path where the pressure losses and pressure value 
upstream from the gas receiver will be calculated. By ticking the check box at the particular receiver 
the user selects the path where they will carry out the calculations. The user is then informed about 
the total design section length and the maximum permissible unit pressure drop. The value of the 
permissible unit pressure drop is determined so that in the path to the receiver the total pressure 
drop will not exceed the value determined for the particular connection type. 
 
Once the check box is ticked, the lower calculation table is filled. Calculations will be carried out  
starting from the selected receiver and ending at the main box. The software calculates the line 
losses and local losses in the design sections and provides the total pressure loss in the path to the 
gas receiver. The following values are listed under the table: 

 Sum of pressure losses [Pa] – the total of all the pressure losses in the calculation path, 

 pressure recovery/loss – pressure change resulting from the difference in gas and air density 

and the height of the gas receiver installed. In case of a gas that is lighter than air pressure is 

recovered, whereas in case of a gas heavier than air there is a pressure loss and the value is 

negative. 

 total pressure loss – pressure drop accounting for the recovery or loss 

 minimum and maximum gas pressure upstream from the gas device. 
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  

Drawing 59. Calculation tables view 

The table's columns include: 
 
Column 1 – Design section name constituting the route between the gas source and the receiver. 
Design section marking. Beginning and ending design sections node numbers.  
After selecting the design section and carrying out calculations, design section markings will appear 
in the projection and the extension. Changing the design route selection causes the design section 
markings for the new routes to be re-drawn.  
 
Column 2 – Real gas flow 
If the heat power M of a gas device is known and the fuel value determined in the gas box 

parameters window is also known, the following parameter is calculated: 

Real gas flow Qr = (M/Hi) x 3.6 [m3/h], 

where: 

M - receiver power in kilowatts [kW] 

Hi – gas fuel value [kW/m3]. 

If the design section supplies gas to n receivers, information about the total power of the supplied 

receivers is assigned to it. 

Real gas flow – Qr = (ΣM/Hi) x 3.6 [m3/h] 

 

Column 3 – Simultaneity factor 

A simultaneity factor value is assigned to the design section. The value is calculated using R.Zajda's 

formula f = 1/n0.52, where n is the number of simultaneity groups. 

Column 4 – Design gas flow 

The design flow is the product of the real flow and the simultaneity factor. 
Qobl = Qr x f,  
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where f is the simultaneity factor. 
 
If the design section supplies gas to m gas receivers (m – number of receivers) divided into n 
simultaneity groups (n – number of simultaneity groups) and for k gas receivers not included in a 
simultaneity group, then the design section gas flow calculation formula for the i-section will be: 
 

Qobl, i = (Q1 x fn + Q2 x fn + Q3 x fn + ……. + Qm x fn) + Qa + Qb + Qc + ………. + Qk 

 
Q1 ……….. Qm – real gas consumption for receivers included in n simultaneity groups 
Qa ……….. Qk – real gas consumption for k receivers not included in simultaneity groups 
 
Column 5 - Dimensions 
Diameters from the drawing are included in column 5, or if the user selects automatic diameter value 
selection, these will be automatically adjusted. Further calculations will be based on the pipe inside 
diameter. 
 
Column 6 – Calculated velocity 
Column 6 presents the calculated velocity value for a given design section. 
 
Columns 7-11 – Substitute lengths of local resistances 
Shut-off fittings (valves) and moulds, which will automatically assume the diameter of the pipelines, 
may be installed in a particular section. 
 
Each element of the fittings and a mould causes local pressure loss. Local losses are converted into 

the so called substitute lengths Lz for the particular diameter. Substitute lengths of the elements in a 

design section will be summarized and their total will then be added to the length of a particular 

design section. In other words, the real design section length will be increased by the total of the 

substitute lengths.  

Tab. 6. The substitute lengths for fittings and moulds in meters of the pipeline with a particular 

diameter 

Fitting types 
Nominal diameters [mm] 

10 15 20 25 32 40 50 65 80 

Ball valve 0.10 0.15 0.30 0.30 0.30 0.40 0.50 0.60 0.90 

Angle valve 0.30 0.40 0.70 0.70 0.80 1.10 1.70 2.10 3.00 

Elbow 0.40 0.55 1.30 1.30 1.50 1.80 1.90 2.10 2.90 

Reducer 0.10 0.10 0.10 0.15 0.20 0.25 0.30 0.50 0.70 

T-straight flow 0.10 0.15 0.40 0.40 0.50 0.70 1.00 1.30 1.80 

T-turning flow 0.25 0.40 0.90 1.10 1.40 1.90 2.70 3.20 4.50 

*Main gas stream at 90◦ 

Column 12 - Section length 
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The real design section length, or in other words the distance between the nodal points, is imported 
from the drawing into this column. 
 
Column 13 - Total section length 
The total section length is the sum of the real length and substitute lengths in the particular section. 
Lco = ΣLz + Lo [m], where: 

ΣLz – substitute lengths total 

Lo – section length 

Column 14 - Unit pressure loss  
Calculating the unit pressure loss (per 1 m of the pipeline)  
The unit pressure drop is calculated using the formula: 

 

∆ℎ𝑗 = 𝐻𝑚𝑖𝑛.𝑖 ∙ (1 − √1 − 1.25 ∙ 108 ∙ 𝜆 ∙ 𝜚𝑔 ∙
𝑄𝑜𝑏𝑙

2

𝑑5 ∙ 𝐻𝑚𝑖𝑛.𝑖
) 

where: 
Δhj – unit pressure drop (Pa/m), 

Hmin– minimum installation input pressure [Pa], 

λ – pipeline wall friction factor, 

d – pipeline inside diameter (mm), 

Qobl – design flow [m3/h]. 

Calculating the friction factor 

 
 

𝜆 =

[
 
 
 
 
 

−2𝑙𝑔

(

 
 
 

2.51

𝑤𝑟𝑧𝑜𝑏𝑙 ∙ 𝑑 ∙ 0.001
𝜈

∙
√

0.3164

(
𝑤𝑟𝑧𝑜𝑏𝑙 ∙ 𝑑 ∙ 0.001

𝜈 )
0.25

+
𝑘

3.71 ∙ 𝑑

)

 
 
 

]
 
 
 
 
 
−2

 

where: 

v −  gas kinematic viscosity (for group E natural gas the kinematic viscosity shall be assumed at 
14.3x10-6 m2/s), 
k – roughness factor (0.045mm for steel pipes and 0.0015mm for copper pipes), 
Wrzobl – real design velocity: 

𝑤𝑟𝑧𝑜𝑏𝑙 =
𝑄𝑜𝑏𝑙

3600∙𝐴
 [m/s], 

where: 

A – the internal pipe cross-section area is calculated using the formula: 
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𝐴 =  𝜋
(𝑑 ∙ 0.001)2

4
 [𝑚2] 

While selecting the automatic diameter selection function, the pressure loss value in a particular 

section per 1 m of the pipeline should not exceed Δhmax = Δhd/1.3 Lc [Pa/m]. 

Column 15 – Pressure loss 

The pressure loss Δh on the design section is calculated in this column. 

Δh = Lco x Δhj [Pa] 

Total pressure loss control 

The value of the section slopes listed in column 15 will be summed up, giving the sum of pressure 

losses in the design route ΣΔh 

Pressure recovery/loss calculation control 

Pressure loss due to the difference of heights between the source of gas (pipeline end next to the 

main gas box) and the highest gas receiver in a particular route occurs in gas installations. This is the 

so-called pressure recovery or pressure loss 

If the specific density of the gas fuel is lower than air density under the same pressure and 

temperature conditions, then pressure recovery will occur (positive value). 

If the gas density is higher than that of air, a pressure loss will occur (negative value) . 

Δhod = (ρp – ρg) x (Wo – Ws) x 9.81 [Pa] 

where: 

Ws – height of the lowest point at the gas box [m], 

Wo – height of the highest installation point at the gas receiver [m], 

ρp – air density (1.293 kg/m3 under normal conditions), 

ρg – gas density under the same pressure and temperature conditions as for air. 

Total pressure loss control 

The total pressure loss is calculated as the difference between the sum of pressure losses and the 

value of recovered pressure 

ΔH = ΣΔh – Δhod [Pa] 

Minimum gas pressure upstream from the gas receiver is calculated using the formula: 

Pmin = Ppmin – (ΔH x 1000) [kPa] 

Maximum gas pressure upstream from the gas receiver is calculated using the formula: 
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Pmax = Ppmax – (ΔH x 1000) [kPa] 

Designed installation diameters validity assessment criteria 

The diameters assumed for the particular design paths must meet the conditions for comparison 

with the permissible values. 

Permissible pressure loss on a critical path 

ΣΔh ≤ Δhd – the total of section pressure losses should be lower or equal to the permissible pressure 

loss in the critical path from the least favorably located receiver to the gas box. 

Minimum pressure criterion upstream from the gas receiver – in each design path 

Pmin ≥ Pd min 

Minimum pressure criterion upstream from the gas receiver – in each design path 

Pmax ≤ Pd max 

If in a particular design path the designer does not obtain values that meet the criterion or better 

diameter optimization is possible, it is possible to change the diameters of the pipeline set 

constituting a particular design section. 

 

7.3 CALCULATION DIAGRAMS AND REPORTS 

Once a drawing is created and verified for validity, the designer may generate a calculation diagram 
in the form of an extension and axonometry. 

7.3.1 Gas installation extension 

Entire installation extension 

 

Click the icon: 
 
ArCADia software:  

 Gas ribbon  Gas installations logical group   

AutoCAD or INTERsoft-INTELLICAD software:  
 

 Gas installations toolbar    

 
or write  
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 IGAS_AMPLVA. 
 
After clicking the Insert extension icon, locate the view handle of the extension area on the drawing.  
 

 

Drawing 60. Extension handle view 

A modification window becomes available after selecting the handle. 
 

The extension drawing can be copied, if manual refreshing option is turned on . The handle 

location against view may be changed from this window by clicking the icon , and then clicking on 

the new position. The view can be deleted by clicking the delete icon . The user may also click the 

properties icon  and the view properties dialog box will become available. 

 

Drawing 61. Axonometry view properties window 

In the properties window is possible to select whether the extension view should be refreshed 

manually or automatically. Automatic refreshing may slow down the software slightly when working 

with large installations, as the extension drawing is copied each time an element is added or 
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removed from the projection. In such a case manual refreshing allows the user to make several 

changes and refresh the drawing afterwards. 

After clicking on the frame of the inserted extension, an extension modification window appears. 

 

Drawing 62. Extension modification window 

The  icon refreshes the view when working in the manual refreshing mode.   

After clicking the icon , the user may insert a spot height for selected pipelines by clicking on them. 

A spot height will be inserted automatically. 

Extension marking, inserted in the extension view, can be turned off and on by clicking the  icon.  

 

Drawing 63. Spot height modification window view 

 

Drawing 64. Spot height properties window 

Extension view properties may be displayed by clicking the  icon – in such a case the Object 

properties: Extension window will become available (Drawing 65). 
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Drawing 65. Extension properties window 

Offset designations may be changed in this window: symbols or lines and after selecting Update all 

the changes will be applied to all offsets. 

After selecting an element in the extension, a modification window will become available. 

1. Items 

 

Drawing 66. Extension item modification window 

 

Drawing 67. Extension item properties window 

2. Pipelines 
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Drawing 68. Extension pipeline modification window 

Enable/Disable apparent shortening – by clicking on this icon the user may determine two 

points on the selected pipeline, which will delimit the section where the pipeline is to be “apparently 

cut out” so that pipe is apparently shortened. 

 

Drawing 69. Selecting the element section for shortening and view after apparent shortening. 

 – Change extension direction – the software automatically generates extensions, also from 

vertical pipelines. The user may change the direction of the extension by marking a distant pipeline 

which is a direct extension of a vertical pipe (Drawing 70). 

 

Drawing 70. Selected pipeline view  

  – deleting and re-adding automatically created offsets. 
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Installation section extension 

 

Click the icon: 

 

ArCADia software:  

 Gas ribbon  Gas installations logical group   
AutoCAD or INTERsoft-INTELLICAD software:  

 

 Gas installations toolbar    
 

or write  
 

 IGAS_AMPLVB. 
 
After clicking the installation section extension icon, the user defines which part of the installation 
shall be visible on the extension. An extension will be created from the selected pipe to the receivers 
located on a given branch.  

 

7.3.2 Gas installation axonometry 

Entire installation axonometry 

 

Click the icon: 

ArCADia software:  

 Gas ribbon  Gas installations logical group   
 

AutoCAD or INTERsoft-INTELLICAD software:  

 

 Gas installations toolbar    
 

or write  
 

 IGAS_AXVA. 
 
Inserting and editing the axonometry view itself is analogous to inserting an extension view.  
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Installation section axonometry 

 

Click the icon: 

ArCADia software:  

 Gas ribbon  Gas installations logical group   
 

AutoCAD or INTERsoft-INTELLICAD software:  

 

 Gas installations toolbar    
 

or write  
 

 GAS_AXVB. 
 
Inserting and editing the installation section axonometry view is analogous to inserting an extension 
view. 

 

Drawing 71. Axonometry modification window 

After clicking the  icon, the user may insert a spot height for the selected pipelines by clicking on 

them. A spot height will be inserted automatically. 

 

Drawing 72. Spot height modification window view 
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Drawing 73. Spot height properties window 

After clicking the  icon, extension marking inserted in the extension view can be enabled or 

disabled. 

The user may also click the go axonometry view properties icon  – in such a case the Axonometry 

element properties window will become available. 

 

Drawing 74. Axonometry properties window 

Axonometry type – the user can select four types of axonometry from a drop-down list. Installation 

axonometry is also available apart from the standard types such as Isometry, Cavalier axonometry 

and Cavalier diameter. The former maintains the lengths from the projections in the axonometric 

view and is recommended when drawing a view of the entire system, rather than a branch of the 

installation and in the case of an installation that runs with parallel pipelines without slope. 

 

Offset designations – the user selects one of the two offset insertion possibilities for the 

axonometry: these can be reference lines or reference symbols and an Update all checkbox. Once 

the checkbox is ticked, all the offsets introduced into the axonometry will change their reference 

markings and the subsequently introduced ones will already be those selected from the list.  

7.3.3 Lists and material lists 

To insert a Material list, click on the icon: 

ArCADia software:  
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 Gas ribbon  Gas installations logical group   

AutoCAD or INTERsoft-INTELLICAD software:  

 Gas installations toolbar    

or write  

 IGAS_SLI 

To insert a Gas installation items list, click on the icon: 

ArCADia software:  

 Gas ribbon  Gas installations logical group   

AutoCAD or INTERsoft-INTELLICAD software:  

 Gas installations tool bar    

or write  

 IGAS_IL. 

Clicking table lines or going to Properties allows the user to edit the table content. 

After clicking the  button you can also generate RTF reports. After clicking the  button you can 
export the data from a material list to Ceninwest. 

 

Drawing 75. Gas installation element list insertion window 

 

Drawing 76. Gas installation material list modification window 
 

A material list or an item list may be selected after inserting. In such a case a modifications window, 

with an icon for marking the selected elements on the projection , becomes available. After 

clicking on a given icon the user may define the position in the list using the mouse. The highlighted 

table row can be clicked and all the elements from this row will be selected on the projection. All 
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selected items can have their parameters changed e.g. Type parameters (diameter, manufacturer, 

connection type or other parameters). 

 

 

Drawing 77. Settings view with selected elements 

 

 

 
 

 


